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ABSTRACT 

Headquarters, United States Marine Corps Installation and Logistics (I&L), is responsible 

for executing United States Marine Corps (USMC) logistics policy and management. One 

of its primary functions is to analyze the suitability and affordability of the annual 

budgets proposed by the three Marine Force (MARFOR) Commands. A major concern in 

achieving this is the proper resourcing and budgeting of Secondary Reparables and 

Consumables in the USMC. 

Several databases are used in the USMC’s financial management, logistics, 

budget-building, and cost-estimation processes. They are the Marine Corps Integrated 

Maintenance Management System (MIMMS), the Supported Activity Supply System 

(SASSY), and the Standard Accounting, Budget and Reporting System (SABRS). This 

thesis combines the data used by MIMMS and SASSY, in conjunction with the updated 

cost indices from SABRS, to improve fiscal year budget forecasts. The databases were 

merged and summarized by Table of Authorized Materiel Control Numbers and by 

MARFORs. 

Augmented with appropriate inventory data, this merged database forecasted 

FY2011 MARFOR budgets using best fit regressions. A key assumption was that the 

inventory levels were kept constant from the previous fiscal year. The final budget 

forecasts derived are to be used by I&L in its next Planning, Programming, Budgeting 

and Execution System (PPBES) meeting. 
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EXECUTIVE SUMMARY 

Headquarters, United States Marine Corps Installation and Logistics (I&L), is responsible 

for executing United States Marine Corps (USMC) logistics policy and management. One 

of its primary functions is to analyze the suitability and affordability of the annual 

budgets proposed by the three Marine Force (MARFOR) Commands. A major concern in 

achieving this is the proper resourcing and budgeting of Secondary Reparables and 

Consumables in the USMC. 

Several databases are used in the USMC’s financial management, logistics, 

budget-building, and cost-estimation processes. They are the Marine Corps Integrated 

Maintenance Management System (MIMMS), the Supported Activity Supply System 

(SASSY) and the Standard Accounting, Budget and Reporting System (SABRS). This 

thesis combines the data used by MIMMS and SASSY, in conjunction with the updated 

cost indices from SABRS, to improve fiscal year budget forecasts. The databases were 

merged and summarized by Table of Authorized Materiel Control Numbers (TAMCNs) 

and by MARFORs. 

The initial step taken was to combine MIMMS and SASSY databases, using 

Microsoft Access, for homogeneity of the data and ease of analysis. Price indices from 

the SABRS were then used to update prices in the combined database. This combined 

database was subsequently exported to Microsoft Excel, where inflation indices from the 

Fiscal Year Enhanced Inflation Calculator from NCAA (Naval Center for Cost Analysis) 

were used to update the prices to FY 2010 before analysis.  

Second, regression analysis was applied to model the relationship between two 

independent variables, the fiscal year and the inventory levels, and the dependent variable 

of cost per year. This was done for each TAMCN and each Regional Activity Center 

(RAC). Both linear and log-linear regressions were analyzed to determine best fit. 

TAMCNs in the Marine Corps Bulletin (MCBUL) 3000 were used for the analysis 

purposes, while the RACs were taken from the 3 largest contributors (MARFORCOM, 

MARFORPAC and MARFORRES).  
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Analysis showed that 50% of the total contributing actual costs incurred in FY 

2010 could be attributed to TAMCNs with regressions that had R2 values exceeding 60%.  

An interesting discovery was that of the remaining regressions with very low R2 

values (those below 60%), 33.3% of the total contributing actual costs incurred in FY 

2010 could be attributed to nine specific TAMCNs, which were either combat vehicles or 

radio communication equipment. The remaining 16.7% of the total contributing actual 

costs were regressed as a group, and a statistically significant regression was found for 

this group.  

Third, Marine Force budgets for FY 2011 were then forecasted using the best 

fitting regressions. A key assumption in this phase was that the inventory levels were 

kept constant from the previous fiscal year. 
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I. INTRODUCTION 

A. BACKGROUND 

Headquarters, United States Marine Corps Installation and Logistics (I&L), is 

responsible for executing United States Marine Corps (USMC) logistics policy and 

management. One of their primary functions is to analyze the suitability and affordability 

of the annual budgets proposed by the three Marine Force (MARFOR) Commands. A 

major concern in achieving this is the proper resourcing and budgeting of Secondary 

Reparables and Consumables in the USMC. 

Several databases are used in the USMC’s financial management, logistics, 

budget-building, and cost-estimation processes. They are the Marine Corps Integrated 

Maintenance Management System (MIMMS), the Supported Activity Supply System 

(SASSY) and the Standard Accounting, Budget and Reporting System (SABRS). 

However, based on key discussions with Capt Alfredo Romero, Program Manager, I&L, 

users at I&L have expressed a lack of confidence with the cost budgeting information 

provided by the TSC module in the Marine Corps Equipment Readiness Information Tool 

(MERIT) application. MERIT is a web based tool used at I&L to aggregate data from 

MIMMS and SASSY.  

The sponsor contacted the Operations Research Department of the Naval 

Postgraduate School in Monterey, California, for help in increasing their confidence in 

the budget forecasts by additionally utilizing SABRS data that has been properly 

correlated with MIMMS and SASSY.  

1. Marine Corps Equipment Readiness Information Tool (MERIT) 

MERIT is a web based tool that aggregates data from MIMMS and SASSY and 

displays the current readiness posture and detailed supply and maintenance information 

for all USMC readiness reportable TAMCNs (Kelly, 2009). 
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2. Marine Corps Integrated Maintenance Management System 
(MIMMS) 

MIMMS is a maintenance information system that is designed to support 

commanders and logistics managers at all command levels in the execution of ground 

equipment maintenance management functions (LPS-4, 1977). 

3. Supported Activities Supply System (SASSY) 

SASSY is the primary retail supply accounting system for the USMC. It provides 

retail supply accounting functions such as stock replenishment, requirements 

determination, receipts, inventory, stock control, and asset visibility. It provides asset 

visibility to MERIT (Kelly, 2009). 

4. Standard Accounting, Budgeting, and Reporting System (SABRS) 

SABRS is the primary accounting system for the USMC. It matches budget 

formulation data with budget execution information. It allows for the USMC to tie the 

actual fund obligation and execution back to authorized and budgeted amounts (HQMC, 

Jan 2010, Section 2.4.1). 

B. LITERATURE REVIEW 

A literature review was conducted prior to commencement of this thesis. This 

thesis is a follow-on work from two previous NPS theses, one by LCDR Patrick Kelly, 

USN (2009), and the other a joint thesis by Capt Alfredo Romero, USMC and Capt 

Dustin B. Elliot, USMC (2009). Their theses dealt with predicting future USMC 

MARFOR budgets using only the Marine Corps Equipment Readiness Information Tool 

(MERIT). MERIT neither provides output data by TAMCNs, nor does it incorporate the 

actual price indices from SABRS. This thesis extends previous work by including the 

SABRS database, which provides a more accurate cost estimate, and summarizes the 

results by TAMCNs to allow for better budget forecasting.  

A report from John M. Chadwick, Armed Forces Comptroller in 2007 (Chadwick, 

2007) describes the effort by the USMC Comptroller to separate expenditures into 36 
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different macro activities-based costs, using SABRS to provide the actual cost data. This 

is somewhat similar to this thesis, as this thesis aims to delve deeper into the maintenance 

costs by segregating the data via TAMCNs (instead of the broad-based macro-level 

activities), using SABRS to provide actual cost indices. They had faced problems linking 

the activities-based cost to the SABRS database as the costs were not properly collected 

in SABRS. They resolved the linkage problem by aggregating other data fields to act a 

pseudo-pointer to actual activity. This thesis used the Standard Document Number (SDN) 

to link the SABRS database to the MIMMS and SASSY database. 

C. RESEARCH STEPS 

The initial step taken in this thesis was to combine the MIMMS and SASSY 

databases, using Microsoft Access, for homogeneity of the data and ease of analysis. 

Price indices from the SABRS were then used to update prices in the combined database. 

This combined database was subsequently exported to Microsoft Excel, where inflation 

indices from the Fiscal Year Enhanced Inflation Calculator from NCAA (Naval Center 

for Cost Analysis) were used to update the prices to FY 2010 before analysis.  

Second, regression analysis was applied to two independent variables, the fiscal 

year and the inventory levels, to predict the dependent variable of cost per year. Both 

linear and log-linear regressions were analyzed to determine best fit. TAMCNs in the 

Marine Corps Bulletin (MCBUL) 3000 (HQMC, 2009) were used for the analysis 

purposes, while the Regional Activity Centers (RACs) were taken from the three highest 

contributors (MARFORCOM, MARFORPAC and MARFORRES).  

Analysis showed that 50% of the total contributing actual costs incurred in FY 

2010 could be attributed to TAMCNs with regressions that had R2 values exceeding 60%.  

An interesting discovery was that of the remaining regressions with very low R2 

values (those below 60%), 33.3% of the total costs incurred in FY 2010 could be 

attributed to nine specific TAMCNs, which were either combat vehicles or radio 

communication equipment. The remaining 16.7% of the total costs were regressed as a 

group, and a statistically significant regression was found for this group.  
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Third, Marine Force budgets for FY 2011 were then forecasted using the best 

fitting regressions. A key assumption in this phase was that the inventory levels were 

kept constant from the previous fiscal year. 

D. THESIS ORGANIZATION AND CONTENT 

Chapter II defines the flow of information between the various agencies within 

the USMC, detailing the SECREPs and consumables information exchanged as well as 

the methodology for combining the data from the different databases provided by I&L. 

These steps were explicitly requested by the sponsor and are useful for readers of this 

thesis. 

Chapter III contains the analysis of the data set obtained using regression analysis, 

as well as key observations noted. 

Chapter IV provides observations and recommendations based on the analysis 

completed. 
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II. DATA AND METHODOLOGY 

A. INFORMATION FLOW 

This chapter documents the flow of electronic and nonelectronic documents 

between the various agencies within the USMC. It details the information exchanged 

from the moment a piece of equipment is sent for repair until it has completed repair.  

Appendix A provides the following flowcharts: 

 USMC Organizational Maintenance    A.1 

 USMC Organizational Supply     A.2 

 USMC Supply Management Unit  (SMU)   A.3 

 USMC Intermediate Maintenance Activity (IMA)  A.4 

 USMC Repairable Issue Point (RIP)    A.5 

1. USMC Organizational Maintenance 

Organizational maintenance consists of first- and second-echelon maintenance for 

a unit that is usually forward deployed. The flowchart in Appendix A.1 describes the 

process that occurs when a maintenance event commences at the organizational 

maintenance level. 

a. An Equipment Repair Order (ERO) and Equipment Repair Order 

Shopping List (EROSL) are generated and keyed into MIMMS. 

b. If consumables are required, the request is forwarded to the organizational 

supply. 

c. The organizational supply procures the necessary consumables and send 

the consumables to the organizational maintenance for installation. 

d. If secondary reparables (SECREP), which cannot be repaired at the 

organizational maintenance, are required, the request, as well as the 
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damaged SECREP, is forwarded to the IMA. If the SECREP are in-stock 

at the RIP, the RIP returns a functional SECREP to the organizational 

maintenance.  

2. USMC Organizational Supply 

Organizational supply provides consumables to the organizational maintenance. 

The flowchart in Appendix A.2 describes the process that occurs when a request for 

consumables is received at the organizational supply. 

a. Upon receiving an EROSL from the organizational maintenance, the 

organizational supply checks whether the parts are in-stock. 

b. If the parts in-stock, they are issued back to the organizational 

maintenance. If the parts are not in-stock, a request (made in SASSY) is 

sent to the SMU. 

c. Upon receiving the parts from the SMU, the organizational supply 

forwards them to organizational maintenance. 

3. USMC Supply Management Unit (SMU) 

SMU is a central depot where consumables are supplied to the organizational 

supply or IMA. SMU also procures consumables when needed. The flowchart in 

Appendix A.3 describes the process that occurs when a request for consumables is 

received at the SMU. 

a. Upon receiving a SASSY transaction from the organizational supply or the 

IMA, the SMU checks whether the parts are in-stock. 

b. If the parts are in-stock, they are issued back to the requesting agency. If 

the parts are not in-stock, a request is made to procure these parts directly 

from the sources of supply (e.g., external contractors). This procurement 

information is captured in SABRS.  
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c. Once the required consumables are successfully procured from the sources 

of supply, the SMU forwards them to the requesting agency. 

4. USMC Intermediate Maintenance Activity (IMA) 

The IMA repairs SECREPs that cannot be repaired at the organizational 

maintenance. The flowchart in Appendix A.4 describes the process that occurs when a 

request from the organizational maintenance for a SECREP repair is received at the IMA. 

a. Upon receiving an ERO from the organizational maintenance, IMA checks 

whether the SECREP can be repaired. 

b. If it cannot be repaired, the damaged parts are sent back to the RIP. If it 

can be repaired, IMA checks whether the parts are in the SMU. If they are 

not available at the SMU, the parts are ordered thru the SMU. 

c. After the completion of the repair, the repaired SECREP is issued back to 

the organizational maintenance.  

5. USMC Repairable Issue Point (RIP) 

The RIP receives SECREPs that cannot be repaired at the IMA, and either sends 

them for repair or procures a replacement. It issues functional SECREPs back to the 

organizational maintenance. The flowchart in Appendix A.5 describes the process that 

occurs when a damaged part is sent from the IMA. 

a. Upon receiving a damaged SECREP from the IMA, the RIP checks 

whether there is stock on-hand 

b. If there is stock on-hand, it issues a working SECREP back to 

organizational maintenance. If not, it requests contractor support to repair 

or replace the damaged SECREP before returning it to organizational 

maintenance. All transactions are recorded in SABRS. 
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B. DATABASE MERGER 

This section documents the steps taken to import and merge the three databases: 

MIMMS, SASSY and SABRS. 

In sequential order, the steps are: 

 Creating a new database 

 Importing MIMMs 

 Importing SASSY 

 Importing SABRS 

 Forming Relationships 

 Running Queries 

 Updating Inflation indices 

Appendix B provides the detailed steps for the database merger. 

This thesis utilizes Microsoft Access to combine the underlying databases and to 

update the merged database. Figure 1 describes how this thesis aggregates information 

from the MIMMS and SASSY databases using Equipment Repair Order (ERO) indices to 

extract Table of Authorized Materiel Control Number (TAMCN) information from 

MIMMS and updating SASSY with the TAMCN data. Only the TAMCNs found in the 

MCBUL 3000 were used. SABRS data that matched the records in SASSY were then 

used to update the costs in the combined database. The analysis thus utilizes a MIMMS-

SASSY combined database as the primary database for further analysis, supplemented by 

the SABRS cost data.  

SDN captured in SABRS that did not appear in SASSY were not processed in this 

thesis. This was due to the difficulty in attaching a TAMCN number to these records, as 

the SABRS database did not include TAMCN data. 

Finally, an aggregation of cost by TAMCN, RAC and year was taken and 

exported to Microsoft Excel for further analysis. 
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Figure 1.   Broad overview of database aggregation 
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III. ANALYSIS OF DATA 

The following section describes how the cost data extracted from the MIMMS 

and SASSY were analyzed. This cost data were combined with inventory data provided 

by HQMC I&L. Regressions were performed using different models to explore and 

evaluate the best least squares model to utilize. The analysis of the data was focused on 

the TAMCNs found in the MCBUL 3000 (USMC, 2009). 

Further analysis showed that certain TAMCNs could not be accurately modeled 

using the current data at hand. For further studies, these TAMCNs would need to be 

examined in greater detail, possibly adding additional variables like operational tempo 

(OPTEMPO). 

A. INTRODUCTION TO LINEAR LEAST SQUARES 

Linear least squares (also known as ordinary least squares (OLS)) was the main 

regression model used to analyze the data in this thesis and is described below 

(Montgomery, Peck, & Vinning, 2006, chapters 2 and 3). 

Regression Analysis is a common statistical method for estimating unknown 

variables. A 2 variable linear regression model is displayed in Equation 1. 

0 1 1 2 2y x x        

Equation 1.   Multiple linear regression model 

In this model, y is the response (or dependent) variable (or in our case, commonly 

the cost expended in a financial year) while x1 and x2 are the regressors (or independent 

variables, in our case financial year, inventory or both). The model attempts to minimize 

the sum of the squares of the vertical distances (not Euclidean distances) from the 

observed responses to the predicted responses predicted by the model. An exponential 

model can be modified to a log-linear model, by a transformation, as seen in Equation 2. 
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     
1 2

1 2

1 1 2 2

exp( )

ln( ) ln ln ln

y Ax x

y A x x

  
  



   
 

Equation 2.   Exponential regression model 

This transformation converts an exponential relationship into a linear relationship, 

thereby permitting the use of the tools developed for the linear case. Such models have 

been used by cost estimators and found useful, especially in cases involving “learning” 

that accompanies repeated tasks (Nussbaum, 2010). It was hoped that the process being 

investigated in this thesis might display some “learning” characteristics. This implies that 

the input to the linear regression model must be the logarithm functions of the response 

variables and the regressors.  

1. Objective: Estimating Unknown Parameters 

There are several computational methods to determine the unknown parameters 

( 0 1 2, ,   ). The method that was utilized in this thesis involves a call to the LINEST 

(Microsoft, 2010)  function in Microsoft Excel. This is an alternative to utilizing the Data 

Analysis package (commonly installed in most versions of Microsoft Excel) to call the 

Regression Function. 

One advantage of using the LINEST function is the ease of calling the LINEST 

function multiple times to generate many regressions for further analysis. For example, in 

researching this thesis, more than 4000 regressions were generated. 

The LINEST function is input into a 5 by x (where x is the number of regressors, 

plus 1) array. The format of the output is shown in Figure 2, where: 

 Cells A1 to E1 with the entries mn are the equivalent of i , 

 Cell F1 with the entries b is the equivalent of 0   
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Figure 2.   Output of LINEST function 

2. Objective: Checking Model Adequacy 

The following parameters were used to check for model adequacy. 

a. R2 Values (Coefficient of Determination) 

The R2 values describe the fit of the overall model. This value can vary 

from 1 (where the model has a perfect fit) to 0 (where the model has no predictive 

ability). Usually, a higher R2 value is preferred in a model. However, considering R2 

values to determine the goodness of fit is a simplified but convenient method. 

In the LINEST output, this refers to cell A3 in Figure 2. 

b. p-Values and t-Statistics 

The p-Values and t-Statistics describe the contribution of the regressors to 

the overall model. In other words, they are testing whether any of the coefficients 

( 0 1 2, ,   ) might be equal to zero. Generally, we want p-values smaller than 0.05 and 

larger t-values in order to reject the null hypotheses that coefficients are zero. 

In the LINEST output, t-Statistic is calculated by dividing Cell A1 by Cell 

A2 and the p-Statistic is calculated by calling a function “TDIST(A1/A2,B4,2).” This 

finds the probability that a random variable having a Student t-distribution, with the 

appropriate degrees of freedom, is not within the interval defined by [–the observed 

statistic, + the observed statistic]. 
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B. EXCEL SPREADSHEET SETUP 

This section is intended to help readers of this thesis. 

1. Key Functions Used 

The key functions that were used were LINEST (described in Section A.1), 

PivotTable and INDIRECT. 

INDIRECT provides a method to call certain addresses in other worksheets using 

a text argument. For example, if the Cell A1 held the string ‘B’ and Cell A2 held the 

number 5, then INDIRECT(A1&A2) will return the value of the Cell B5. This essentially 

enables the spreadsheet to setup quickly and efficiently, by using indexes to call to other 

cells. 

PivotTable is another important function that summarizes the spreadsheet data by 

consolidating them into user-defined sections. For example, given a spreadsheet 

containing Years, TAMCNs, Regional Activity Center (RAC) and Cost, the PivotTable is 

quickly able to summarize the cost spent over all the years by RAC. 

2. Regressions Models 

In the analysis, six different models of regressions were developed for each 

TAMCN–RAC pair. These six regressions were analyzed for their quality using the 

methodology mentioned in Section A.2. In each model, the dependent variable, inventory 

levels, represented the possessed quantities, rather than the authorized quantities. The six 

models, with descriptions, are presented in Equation 3. 
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Model A:  

Model B:   

Model C:   

Model D:   

Model E:   

Model F:   

Equation 3.   Regression models used 

Model A depicts a linear relationship between the year and the cost incurred for 

each TAMCN–RAC pair. This implies that every year, the cost is increasing (or 

decreasing) by a constant amount. For example, if the factor is determined to be 0.20 

million/year, and $1 million was spent in year 2010, the model will predict that in year 

2011, $1.20 million will be spent and that $1.40 million will be spent in year 2012.  

Model B depicts a linear relationship between the inventory and the cost incurred 

for each TAMCN–RAC pair. This implies that every item held in inventory entails a 

certain cost. For example, if the factor is determined to be 0.20 million per equipment, 

and $1 million was spent in year 2010 for three pieces of equipment, the model will 

predict that in year 2011 (if the same three pieces of equipment are held), $1.00 million 

will be spent. The model will also predict that $1.40 million will be spent in year 2012, if 

two additional pieces of equipment are acquired, causing five pieces of equipment to be 

held. 

Model C depicts a linear relationship between the inventory and year and the cost 

incurred for each TAMCN–RAC pair. This implies that every year, the cost is changing 

linearly at a certain constant factor, as well as linearly for every item held in inventory. 

For example, if the factor is determined to be 0.20 million per equipment and 0.5 million 

per year, and $1 million was spent in year 2010 for three pieces of equipment, the model 
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will predict that in year 2011 (if the same three pieces of equipment are held) $1.50 

million will be spent. The model will also predict that $2.40 million will be spent in year 

2012, if two more pieces of equipment are acquired, causing five pieces of equipment to 

be held.) 

Model D depicts an exponential relationship between the year and the cost 

incurred for each TAMCN–RAC pair. This implies that costs are changing over time in a 

specific way, namely that the costs in year n and the costs in year 2n are related as 

follows: 

  1
2n n 2Cost Cost   

Equation 4.   Relationship of costs in a log-linear model (Model D) 

Model E depicts a linear relationship between the year and the average cost per 

inventory held incurred for each TAMCN–RAC pair. This implies that every year, the 

cost per item held changes by a fixed amount. For example, if the factor is determined to 

be 0.20 mil/year, and $1 million was spent in year 2010 for three pieces of equipment 

(average 0.33 million per equipment), the model will predict that in year 2011 (if the 

same three pieces of equipment are held), $1.60 million (average of 0.53 million per 

equipment) will be spent. The model will also predict that $3.60 million (average of 0.73 

million per equipment) will be spent in year 2012, if two more pieces of equipment are 

acquired, causing five pieces of equipment to be held. 

Model F depicts an exponential relationship between the year and the average cost 

per inventory held incurred for each TAMCN–RAC pair. This implies that every year, 

the cost per item held are changing over time in a specific way, namely that the costs in 

year n and the costs in year 2n are related as follows: 

  1
year 2y year y    2Cost per inventory Cost per inventory   

Equation 5.   Relationship of costs in an exponential model (Model F) 
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3. Regression Adequacy and Classification 

A regression is deemed to be adequate if it satisfies the following constraints: 

 At least 3 years of relevant data (2008, 2009 and 2010) data must be 

available. This is to ensure that the regression is not the trivial task of 

drawing a line between two points. 

 Dependent variables must have a p-value of greater than 95%. 

If the best adequate regression had a R2 value of at least 80%, the TAMCN–RAC 

will be flagged as “GOOD.” If the best adequate regression had only a R2 value of 60%, 

the TAMCN–RAC will be flagged as “OKAY.” However if either the best adequate 

regression had only a R2 value of less than 60% or none of regressions were determined 

to be inadequate, the TAMCN–RAC pair will be flagged with a “BAD.” 

Summarizing, the algorithm is as follows: If there exists at least one regression 

that is adequate and has more than 3 years of data, check its R2 value: if it is >80%, label 

as “GOOD”; if it is >60%, label as “OKAY”; or else label it as “BAD.” This algorithm is 

summarized in Figure 3. 

Regression

p‐value > 0.95
&  > 3  years data

R2 > 80%

R2 > 60%

GOOD

OKAY

BAD

Yes

Yes

No

NoNo

Yes

 

Figure 3.   Algorithm for determining the label of a regression 

C. INITIAL ANALYSIS 

The contribution of each TAMCN to overall cost in Fiscal Year (FY) 2010 was 

considered. This contribution was sorted from the highest contribution to the lowest. 



 
 

18

The initial analysis plan involved developing models for the set of TAMCNs that, 

in total, constituted 80% of the total cost.  

The list of 40 TAMCNs that contributed to 80% of the total cost is summarized in 

0 

TAMCN Description TAMCN Description 
A0067 HIGH FREQUENCY VEHICLE 

SYSTEM 
B0160 ASSAULT BREACHER VEHICLE 

A0069 RADIO SET B1021 GENERATOR SET, SKID-MTD, 
60KW/60HZ, TQG 

A0139 RADIO SET B2567 TRACTOR, RUBBER TIRE, 
ARTICULATED STEER, MP 
(TRAM) 

A0273 RADIO SET D0003 TRUCK, ARMORED, CARGO, 7 
TON W/O WINCH, REDUCIBLE 

A0806 SAT TERMINAL, MULTIBAND, 
LTWT (LMST) MAXI-HUB 

D0198 TRUCK, RTAA, CARGO, 7T, 
WITHOUT WINCH 

A0807 SAT TERMINAL, MULTIBAND 
LTWT (LMST) MINI HUB 

D0209 POWER UNIT, FRONT, 12 1/2T, 
4X4 

A1440 RADAR SET, FIREFINDER D1158 TRK, UTIL, CARGO/TRP CARR, 1 
1/4T, W/EQP, HMMWV 

A1500 RADAR SET, AIR TRAFFIC 
CONTROL, LTWT 

D1159 TRK, UTIL, ARMT CARR, W/SA, 2 
1/4T, HMMWV 

A1503 RADAR SET D1213 TRUCK, RTAA, WRECKER, 7TON, 
W/WINCH 

A1955 TERMINAL SET, RADIO E0665 HOWITZER, MEDIUM, TOWED, 
155MM 

A1957 RADIO SET E0671 HOWITZER, LTWT, TOWED, 
155MM 

A2042 RADIO SET, HIGH FREQUENCY, 
MANPACK 

E0796 ASSAULT AMPHIBIOUS 
VEHICLE, COMMAND 

A2043 RADIO SET, MULTIBAND (URBAN) E0846 ASSAULT AMPHIBIOUS 
VEHICLE, PERSONNEL 

A2044 RADIO SET, MULTIBAND 
(MARITIME) 

E0856 ASSAULT AMPHIBIOUS 
VEHICLE, RECOVERY 

A2068 RADIO SET, MULTIBAND, FALCON 
II 

E0935 LAUNCHER, TUBULAR, F/GM 
TOW WPN SYSTEM 

A2079 RADIO SET, MANPACK E0947 LAV, LIGHT ASSAULT, 25MM 
A2152 RADIO SET, EPLRS E0989 MACHINE GUN, MEDIUM, 

7.62MM, GROUND VERSION 
A2179 RADIO TERMINAL SET E1095 MORTAR, MEDIUM, 81MM, 

EXTENDED RANGE 
A2525 TACTICAL AIR OPERATIONS 

MODULE 
E1378 RECOVERY VEHICLE, FT, 

HEAVY, W/EQUIP 
A3232 TACTICAL SATCOM, 

TRANSPORTABLE (SMART-T) 
E1888 TANK, COMBAT, FT, 120MM GUN 

 

Table 1.   Initial set of TAMCNs 
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Examination of this table reveals that vehicles and communications equipment 

make up most of the set. This is unremarkable by itself, except that the same observation 

is made later in the chapter, under somewhat different circumstances. 

Regressions were performed on the items on this list, and the results were divided 

into two classes: 

1. TAMCNs for which regressions performed well, in the sense previously 

described 

2. All other TAMCNs 

Unfortunately, the TAMCNS in the first class constituted only 40% of the entire 

FY 2010 Cost. In an attempt to develop a higher proportion, the analysis also was done 

on the remaining TAMCNs that made up the remaining 20% of the cost.  

D. SECOND ANALYSIS 

The regressions were repeated for the entire set of 230 TAMCNs found in the 

MCBUL 3000 bulletin, and the overall results are presented in Table 2. Note that 

MIM001 and MIM003 refer to Marine Force Pacific (MARFORPAC), MIM002 refers to 

Marine Force Command (MARFORCOM) and MIM004 refers to Marine Force Reserve 

(MARFORRES). Appendix C contains a link to the full set of regression results. 

RAC Description “GOOD” “OKAY” “BAD” Total 
Number 60 25 120 205 MIM001 

Sum of Cost $605 mil $149 mil $1,132 mil $1,887 mil 
Number 46 27 130 203 MIM002 

Sum of Cost $427 mil $160 mil $509 mil $1,096 mil 
Number 35 37 120 192 MIM003 

Sum of Cost $103 mil $66 mil $117 mil $285 mil 
Number 34 26 111 171 MIM004 

Sum of Cost $112 mil $65 mil $42 mil $219 mil 
Number 175 115 481 771 Total 

Sum of Cost $1248 mil $440 mil $1,800 mil $3,487 mil 
 

Table 2.   Regression results across RACs 
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For example, in MIM004 (MARFORRES), there were 111 “BAD” regressions, 

contributing to $42 million of the overall cost in FY 2010. 

The “Number” row describes the number of TAMCN–RAC pairs that result in 

“GOOD,” “OKAY,” or “BAD” regressions. The sum of cost is the sum of actual 

contribution of the TAMCNs that fall into that category based on the cost incurred in FY 

2010.  

Figure 4 is a visualization of the data in Table 2. It depicts the FY 2010 cost of the 

contributing TAMCNs by RAC. 

 

Figure 4.   Chart of regression results over RACs 

The general trend can be summarized as follows: About 50% (i.e., [$1248 mil + 

$440 mil] / $3,487 mil) of the cost in FY 2010 can be predicted with significant accuracy. 

However, this fraction varies across the RACs. Note: Manual adjustments were made for 

certain log-linear models that exhibited large exponential growth (>100% increase per 

year). For each of these TAMCN–RACs pairs, the next best adequate regression was 

selected. The list of adjustments is attached as Appendix D. 
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E. ANALYSIS OF “BAD” REGRESSIONS 

The “BAD” regressions were sorted into two groups, TAMCNs with a significant 

contribution and TAMCNS with a nonsignificant contribution. The process is described 

in Figure 5. 

“BAD”
Regressions

Significant 
Contributors
Chapter 4.E.1

Non‐Significant 
Contributors
Chapter 4.E.2

List of 9 
TAMCNs

Aggregated
Linear

Regression
 

Figure 5.   Algorithm for analyzing “BAD” regressions 

1. TAMCNs With a Significant Contribution to “BAD” Regressions 

The “BAD” regressions were analyzed separately. These TAMCN–RAC pairs can 

be divided, in a similar fashion as in Chapter III Section C, identifying the largest 

TAMCNs, which together constitute 66.7% of the total cost of the “BAD” regressions in 

Table 2. In this case, nine TAMCNs contributed to 66.7% of the total cost of “BAD” 

regressions. The list is summarized in Table 3. “Sufficient Data” means that there was 

sufficient cost data for the TAMCN–RAC pair, but no satisfactory regression could be 

obtained. 
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TAMCN  DESCRIPTION  MIM001  MIM002  MIM003  MIM004 
E0846 ASSAULT 

AMPHIBIOUS 
VEHICLE, 

PERSONNEL  

Sufficient 
Data  

 Sufficient 
Data  

Sufficient 
Data  

E1888 TANK, COMBAT, FT, 
120MM GUN  

 Sufficient 
Data  

  

E0947 LAV, LIGHT ASSAULT, 
25MM 

Sufficient 
Data  

 Sufficient 
Data  

Sufficient 
Data  

D0198 TRUCK, RTAA, 
CARGO, 7T, 

WITHOUT WINCH)  

Sufficient 
Data  

   

A0097 RADIO SET, DUAL 
VEHICLE ADAPTER, 

50-WATT (DVA)  

New 
Equipment 

New 
Equipment 

New 
Equipment  

New 
Equipment 

A1957 RADIO SET Sufficient 
Data  

Sufficient 
Data  

Sufficient 
Data  

Sufficient 
Data  

A1955 TERMINAL SET, 
RADIO 

Sufficient 
Data  

Sufficient 
Data  

Sufficient 
Data  

Sufficient 
Data  

A2068 RADIO SET, 
MULTIBAND, 

FALCON II  

Sufficient 
Data  

Sufficient 
Data  

Sufficient 
Data  

Sufficient 
Data  

A0273 RADIO SET Sufficient 
Data  

Sufficient 
Data  

Sufficient 
Data  

Sufficient 
Data  

 

Table 3.   TAMCNs with a significant contribution to the “BAD” regressions 

Examination of Table 3 reveals, as before, that vehicles and communication 

equipment make up this list. None of the regressions models was able to provide 

satisfactory predictions. It may be that other variables or more detailed and complicated 

multiple regression models would yield more satisfactory results. 

It could be postulated that these equipment items were heavily used in the 

overseas engagements to which the U.S. Marines Corps were deployed. Unfortunately, 

the models in this thesis cannot address this issue because they track the inventory only at 

the “possessed” level. In other words, a piece of equipment that was stored and not used 

was considered to have incurred a similar cost to a piece of equipment seeing active use. 
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A form of numerically assigning a value to Operating Tempo (OPTEMPO) might be a 

way to form new regressions on these TAMCN–RAC pairs.  

In our current model, the costs of these “BAD” TAMCNs were estimated by 

predicting overall budget growth for 2011 (as described in Chapter III Section F) and, 

subsequently, by subtracting sections that can be predicted (as described in Chapter III, 

Sections.D and E.2).  

2. TAMCNs With a Nonsignificant Contribution to “BAD” Regressions 

The remaining TAMCNs, which together constitute 33.3% of the total cost of the 

“BAD” regressions in Table 2, were aggregated and considered for analysis (Table 4). 

RAC 2005 2006 2007 2008 2009 2010 
MIM001 $ 253 mil $ 115 mil $ 168 mil $ 169 mil $ 182 mil $ 314 mil 
MIM002 $ 101 mil $ 132 mil $ 92 mil $ 134 mil $ 170 mil $ 200 mil 
MIM003 $ 289 mil $ 77 mil $ 66 mil $ 173 mil $ 122 mil $ 75 mil 
MIM004 $ 22 mil $ 13 mil $ 19 mil $ 23 mil $ 23 mil $ 22 mil 

Total $ 663 mil $ 337 mil $ 345 mil $ 500 mil $ 497 mil $ 611 mil 
 

Table 4.   Contributing cost of TAMCNs with a nonsignificant contribution  
to the “BAD” regressions 

For each RAC, log-linear and linear regressions were performed on this residual 

list of TAMCNs. The best fit was a simple linear regression model from 2006 to 2010 for 

each RAC. The regression is described in Equation 6. 

n+1 $140,121 ($70 )Cost M M Year    

Equation 6.   Linear Regression Model to describe TAMCNs with a 
nonsignificant contribution to the “BAD” regressions 

The predicted values for 2011 are shown in Table 5. 
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RAC 2010 (Actual) 2011 (Predicted) 
MIM001 $ 314 mil $313 mil 
MIM002 $ 200 mil $210 mil 
MIM003 $ 75 mil $218 mil 
MIM004 $ 22 mil $27 mil 

Total $ 611 mil $668 mil 
 

Table 5.   Predicted cost of TAMCNs that can be aggregated and regressed for 2011 

Figure 6 shows the consolidated actual cost of the remaining TAMCNs, which 

together constitute 33.3% of the total cost of the “BAD” regressions, and plots the 

consolidated predicted values of the simple linear regression. It shows that, for 2011, the 

model predicts that $668 million will be expended on this group. 

‐

$100 

$200 

$300 

$400 

$500 

$600 

$700 

$800 

2006 2007 2008 2009 2010 2011

FY
 2
0
1
0
 $
 m
ill
io
n

Actual Cost Fitted Values

 

Figure 6.   Chart of actual vs. fitted values for TAMCNs with nonsignificant 
contributions to the “BAD” regressions for 2011 (FY 2010 $ million)  
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F. PREDICTING 2011 OVERALL BUDGETS 

In this section, we use fiscal years to predict expenditures. Based on the historical, 

annual, by RAC expenditures, several regression models were considered for modeling 

the increase in expenditures, with results shown in Figure 7. The trend is shown in Table 

6. The model used was the Log-linear model, starting from 2007.  
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Figure 7.   Growth of actual cost expended over all the RACs 

Model  Starting Year  Parameter  R2
 
 2011 Predicted  

Log-linear  2007  39% increase  99.9%  $ 4,772 
Log-linear  2006  27% increase  87.0%  $ 3,980 
Quadratic  2005  N/A  97.4%  $ 5,285 

 

Table 6.   Predicted costs for overall 2011 budget (FY 2010 $ million) 
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G. CONSOLIDATED PREDICTIONS 

Based on the results above, the following predicted values were computed for FY 

2011 (Table 7). This assumes that possessed inventory remains constant (as we do not 

have predicted inventory data for 2011).  

Group A describes the TAMCN–RAC pairs that we have developed adequate 

regressions for (This process was described in Chapter III Section.D). The FY 2011 

predicted values were taken by consolidating the predicted values taken from the models. 

Group B2 describes the TAMCN–RAC pairs that constitute 33.3% of the total 

cost of “BAD” regressions (This process was described in Chapter III Section.E.2). The 

FY 2011 predicted values were taken by using the simple linear regression model 

developed. 

The 2011 Predicted Cost (Grand Total) was computed by using the Log-linear 

model. This process is described in Chapter III Section F. 

Group B1 describes the TAMCN–RAC pairs that constitute 66.7% of the total 

cost of “BAD” regressions (This process is described in Chapter III Section.E.1). The FY 

2011 predicted values were computed by subtracting Group A and B2 from the 2011 

Predicted Cost (Grand Total). 

Note: All predictions are in FY 2010 $M, and will need to be converted to 

FY 2011 $M dollars for budgeting. 
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Group 
B1 

Group 
B2 

 Group A 

“BAD” RAC Cost 
Signi-
ficant 

Not Sig Total 
“GOOD

” 
“OKAY

” 

Grand 
Total 

2010 
Actual Cost 

$819 $314 $1,13
3 

$606 $149 $1,887 MIM00
1 

2011 
Predicted 

Cost 

$1,125 $377 $1,50
2 

$910 $171 $2,583 

2010 
 Actual Cost 

$309 $200 $509 $427 $160 $1,096 MIM00
2 

2011 
Predicted 

Cost 

$434 $240 $674 $641 $184 $1,500 

2010 
Actual Cost 

$42 $75 $117 $103 $66 $285 MIM00
3 

2011 
Predicted 

Cost 

$70 $90 $161 $154 $76 $391 

2010 
Actual Cost 

$20 $22 $42 $112 $65 $219 MIM00
4 

2011 
Predicted 

Cost 

$30 $26 $56 $169 $75 $300 

 

Table 7.   Predicted costs (by RAC) for 2011 budget (FY 2010 $ million) 
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IV. CONCLUSION 

A. SUMMARY OF METHODOLOGY 

The methodology used to compute the predicted costs for 2011 was as follows: 

1. For each TAMCN in MCBUL 3000, extract from the combined database, 

by RAC, the cost per year. 

2. For each TAMCN-RAC combination, use regression to model the costs as 

a function of the independent variables identified in Chapter III Section B.2. Identify 

those models that can be used, based on R2 and p-values. 

3. Classify each useable regression as “GOOD” or “OKAY,” and use it to 

forecast values for 2011. (Group A) 

4. For the TAMCN–RAC pairs with “BAD” regressions, identify the 

significant contributors and place aside for further analysis. The significant contributors 

contribute to 66.7% of this cost (Group B1). The remaining 33.3% of the cost will be 

predicted by a single linear regression. (Group B2) 

5. Compute the expected budget for each RAC, based on a linear regression. 

6. Tabulate all the results. The predicted amount for significant TAMCN–

RAC pairs (Group B1) is estimated by subtracting the expected budget for each RAC by 

(a) predicted amount for “OKAY” and “GOOD” regressions  

(Group A) 

and 

(b) predicted amount of nonsignificant results for TAMCN–RAC pairs 

with bad regressions (Group B2). 
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B. KEY RESULTS 

 Description 2011 Estimated  2010 Actual 
“GOOD” Regressions (R-sq >80%)   $ 1,874   $ 1,248 Group A 
“OKAY” Regressions (R-sq>60%)   $ 505   $ 440 

 “BAD” Regressions (Total)  $ 2,393   $ 1,800 
Group B1  Significant TAMCNS (est.)  $ 1,721   $ 1,189 
Group B2  Nonsignificant TAMCNs  $ 684   $ 611 
 Final Figure (log-linear 99%)   $ 4,772   $ 3,487 

 

Table 8.   Consolidated predicted costs for 2011 budget (FY 2010 $ mil) 

C. MAIN CONCERNS 

The main concerns lie with the significant number of TAMCN–RAC pairs that 

cannot be modeled satisfactorily with our current regression models accurately. These 

TAMCN–RAC pairs appear to be combat equipment seeing a lot of active duty. Further 

analysis on this set of equipment will be needed, perhaps by incorporating a variable to 

represent OPTEMPO. 

 One other discovery was that when the unusable regressions were analyzed, 

66.7% of the cost could be attributed to nine specific TAMCNs, which were either 

combat vehicles or radio communication equipment. These TAMCN–RAC pairs will 

need to be analyzed separately with additional variables to obtain a more credible 

regression (Group B1). 

Data from the databases, due to legacy issues, were badly formatted. Considerable 

effort went into reformatting the data so that the necessary data manipulation and 

aggregation can be performed successfully. The USMC should develop a more consistent 

formatting structure. 
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APPENDIX A.  ORGANIZATIONAL FLOWCHARTS 

A. USMC ORGANIZATIONAL MAINTENANCE POLICY 
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B. USMC ORGANIZATIONAL SUPPLY POLICY 
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C. USMC SUPPLY MANAGEMENT UNIT (SMU) POLICY 
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D. USMC INTERMEDIATE MAINTENANCE ACTIVITY (IMA) POLICY 
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E. USMC REPAIRABLE ISSUE POINT (RIP) POLICY 
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APPENDIX B.  DETAILED STEPS FOR DATABASE MERGER 

A. INTRODUCTION 

This appendix details the steps required for the database merger 

B. CREATING A NEW DATABASE 

Open Microsoft Access and click on [Create New Database]. Save the Database 

under a preferred name. 

Note: Occasionally when performing the steps listed below, certain out-of-

memory issues may occur. If this happens, close all open tables and queries and click 

File-> Compact Database. 

C. IMPORTING MIMMS 

The EroHist.txt (dated June 6, 2010) was used in this import step 

1. Importing Text File 

This process describes the steps needed to perform the text file import. 

a. [External Data]->[Import-Text File] 

b. Specify location of EroHist.txt in the dialog box. Leave the bullet on the 

default position “Import the source data into a new table in the current database.” Click 

[Next] 

c. Select the “Delimited–Characters such as comma or tab separate each 

field” bullet. Click [Next] 

d. Select the “Other:[ ]” bullet. Input the vertical bar “|” in the box. Check 

the box “First Row Contains Field Names”. Click [Advanced] 

Note: sometimes Access will not allow you to input the vertical bar. Pressing 

backspace or delete a few times after selecting the box before inputting “|” might help 
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e. Under the table in “Field Information:” Check all the boxes except for the 

following fields: 

 EQUIP_REPAIR_ORDER_NUM 

 REGIONAL_ACTIVITY_CODE 

 DATE_RECEIVED_IN_SHOP 

 TAM_CONTROL_NUMBER 

 Click [OK]. Click [Finish] 

f. Query will then run for about 5 minutess, depending on processor speed 

Optional: Check [Save Import Steps]. This will allow you to skip this process 3.2 

in future iterations. Click [Save Import]. 

The text import is completed at this point. 

2. Deleting Erroneous Data 

This process allows you to remove records that have faulty 

TAM_CONTROL_NUMBER (or nonexisting). 

a. Click on EroHist: Table (It should be on the tab under the toolbox, if not 

double click on EROHist: Table on the left column) 

b. Click on the header “TAM_CONTROL_NUMBER” and select [HOME]-

>[AZ down arrow]  

c. This will sort the TAM_CONTROL_NUMBER alphabetically 

d. Once the sort is complete. Select the first rows that do not start with an 

alphabet. Press Delete on your keyboard. 

For the current version, 262863 records were deleted 

The deletion of erroneous data is completed at this point. 
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3. Deleting Duplicate Data 

Deleting duplicate data is required for the relationship query to work later. This 

section outlines the steps taken to delete the duplicate data. 

a. Click [CREATE]->[QUERY DESIGN] 

b. In the “Show Table” Dialog, select EroHist and click [ADD]. Click 

[CLOSE] 

c. Click [DESIGN]-> [Query Type/Make Table]. In the dialog box, input the 

“EroHist–no duplicates” under Table Name 

d. In the table below. Input the following information 

 In Field1, Select EQUIP_REPAIR_ORDER_NUM 

 In Field2, Select REGIONAL_ACTIVTY_CODE 

 In Field3, Select DATE_RECEIVED_IN_SHOP  

 In Field4, Select TAM_CONTROL_NUMBER 

 In Table, Select EroHist for all 4 fields 

e. Click [DESIGN]->[Show/Hide–Totals] 

f. Under the Total for field 4 (TAM_CONTROL_NUMBDER), Change it 

from “Group By” to “First” 

g. Click [DESIGN]->[RUN] 

h. Query will run for about 5 min, depending on processor speed 

i. An Alert box saying “You are about to paste 1870509 row(s) into a new 

table”. Click “YES” 

Optional: Right Click on Query1 Tab just below the toolbar, and select “SAVE” 

In the “Save As” Dialog box, save the Query Name as “EroHist-no duplicates 

query” 
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From an initial total of 1.905,557 records, the query returned 1,870,509 records. 

Hence, there were 35,048 additional duplicate entries. This query took all the fields that 

have the same ERO, RAC and Date and compare the TAMCNs. If the ERO, RAC and 

Date are the same, the query took the 1st TAMCN (alphabetically sorted). 

The deletion of duplicate data is completed at this point. 

 
 

Figure 8.   Query to remove duplicate data in EroHist 
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D. IMPORTING SASSY 

The repairparts10.txt (dated Oct 8th 2010) was used in this import step. 

1. Importing Text File 

This process describes the steps needed to perform the text file import. 

a. [External Data]->[Import-Text File] 

b. Specify location of repairsparts10.txt in the dialog box. Leave the bullet 

on the default position “Import the source data into a new table in the current database.” 

Click [Next] 

c. Select the “Delimited–Characters such as comma or tab separate each 

field” bullet. Click [Next] 

d. Select the “Other:[ ]” bullet. Input the vertical bar “|” in the box. Check 

the box “First Row Contains Field Names”. Click [Advanced] 

Note: sometimes Access will not allow you to input the vertical bar. Pressing 

backspace or delete a few times after selecting the box before inputting “|” might help 

e. Under the table in “Field Information:” Check all the boxes except for the 

following fields: 

 EQUIP_REPAIR_ORDER 

 REGIONAL_ACTIVITY_CODE 

 LDRDBA_LDR_MIMMS_REPAIR_PARTSDATE_RECEIVED_IN_SH

OP 

 DOCUMENT_NUMBER 

 QUANTITY_RQUIRED 

 PARTS_CHARGE 

 NATIONAL_STOCK_NUMBER_REQUIRED (Change Data Type to 

Text) 
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 LEGACY_FILE_DTTM    (Change Data Type to 

Text) 

f. In additional for fields (vii) and (viii), change the “Data Type” to “Text”. 

This will prevent Access from throwing errors later. 

g. Click [OK]. Click [Finish] 

h. Query will then run for about 1 min, depending on processor speed 

Optional: Check [Save Import Steps]. This will allow you to skip this process 3.2 

in future iterations. Click [Save Import]. 

The text import is completed at this point. 

2. Updating the LEGACY_FILE_DTTM and DOCUMENT_NUMBER 

This process modifies the LEGACY_FILE_DTTM by throwing out the date and 

month, and keeping only the year. It also pre-pends the letter “M” to standardize the 

DOCUMENT_NUMBER to the SABRS database. 

a. Click [CREATE]->[QUERY DESIGN] 

b. In the “Show Table” Dialog, select Repairparts10 and click [ADD]. Click 

[CLOSE] 

c. Click [DESIGN]-> [Query Type/UPDATE] 

d. In the table below, input the following information 

e. Under Field1, Select LEGACY_FILE_DTTM 

f. In Table, select repairparts10 

g. In “Update to”, input the following information 

“RIGHT([LEGACY_FILE_DTTM],4) 

This will utilize only the last 4 numbers of the LEGACY_FILE_DTTM field 

h. Under Field2, Select DOCUMENT_NUMBER 

i. In Table, select repairparts10 
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j. In “Update to”, input the following information 

“M”&[DOCUMENT_NUMBER] 

k. Click [DESIGN]->[RUN] 

l. Query will run for about 1 min, depending on processor speed 

An Alert box saying “You are about to update 677002 row(s)”. Click “YES” 

[OPTIONAL] Right Click on Query1 Tab just below the toolbar, and select 

“SAVE” 

In the “Save As” Dialog box, save the Query Name as “Repairparts10-update year 

& sdn” 

The data change is completed at this point. 

 
 

Figure 9.   Query to update date and year in Repairparts10 
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3. Deleting Erroneous Data 

This process allows you to remove records that have faulty ERO number. 

a. Click on Repairparts10: Table (It should be on the tab under the toolbox, if 

not double click on Repairparts10: Table on the left column) 

b. Click on the header “ EQUIP_REPAIR_ORDER” and select [HOME]-

>[AZ down arrow] 

This will sort the EQUIP_REPAIR_ORDER alphabetically 

c. Once the sort is complete. Select the first rows that do not start with an 

alphabet. Press Delete on your keyboard. 

For the current version, 7856 records were deleted 

The deletion of erroneous data is completed at this point. 

E. IMPORTING SABRS 

This section will document the steps taken to import the SABRS file. The file 

2ND_MLG (15th Oct 2010) was used in this section. 

1. Copying the File to the Main Database 

This process copies the table over to the main Database so that it can be worked 

on. 

a. Open the second _MLG.db file 

b. Right click on M7446: Table on the left column and right click “Cut” 

c. Go back to your original database (There should be a separate window for 

it) 

d. Right Click on the left column and select “Paste” 

e. The process will take about 5 minutes to import 

The file copy is completed at this point. 
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2. Deleting Duplicate Data 

Deleting duplicate data is required for the relationship query to work later. This 

section outlines the steps taken to delete the duplicate data. 

a. Click [CREATE]->[QUERY DESIGN] 

b. In the “Show Table” Dialog, select M67446 and click [ADD]. Click 

[CLOSE] 

c. Click [DESIGN]-> [Query Type/Make Table] 

d. In the dialog box, input the “M67446–no duplicates” under Table Name 

e. In the table below. Input the following information 

 In Field1, Select Tot Trans Amt 

 In Field2, Select Std Doc No 

 In Table, Select M67446 for all 4 fields 

f. Click [DESIGN]->[Show/Hide–Totals] 

g. Under the Total for field 1 (Tot Trans Amt), Change it from “Group By” 

to “Sum” 

h. Click [DESIGN]->[RUN] 

i. Query will run for about 15 min, depending on processor speed 

An Alert box saying “You are about to paste 10686011 row(s) into a new table”. 

Click “YES” 

Optional: Right Click on Query1 Tab just below the toolbar, and select “SAVE” 

In the “Save As” Dialog box, save the Query Name as “M67446-no duplicates 

query” 

The deletion of duplicate data is completed at this point. 
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Figure 10.   Query to remove duplicate data in M67446 

F. FORMING RELATIONSHIPS 

This section details how to link up the databases with the right relationships 

a. Click [Database Tools]->[Show/Hide–Relationships] 

 In the “Show Table” window 

 Select EroHist-no duplicates, click [ADD] 

 Select M67446-no duplicates, click [ADD] 

 Select Repairparts10, click [ADD] 

 Click [CLOSE] 

b. Click [Design]->[Edit Relationships] 

 MIMMS-SASSY Relationships 

o In the “Edit Relationships” window, click “Create New” 

o In the Left Table Name, select “EroHist–no duplicates” 
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o In the Left Column Name, select 

“EQUIP_REPAIR_ORDER_NUM” 

o In the Right Table Name, select “Repairparts10” 

o In the Right Column Name, select 

“EQUIP_REPAIR_ORDER_NUM” 

o Click OK 

o Add REGIONAL_ACTIVITY_CODE under the left table under 

“EQUIP_REPAIR_ORDER_NUM” 

o Add REGIONAL_ACTIVITY_CODE under the right table under 

“EQUIP_REPAIR_ORDER_NUM” 

o Add DATE_RECEIVED_IN_SHOP under the left table under 

“REGIONAL_ACTIVITY_CODE” 

o Add 

LDRDBA_LDR_MIMMS_REPAIR_PARTSDATE_RECEIVED_

IN_SHOP under the right table under 

“REGIONAL_ACTIVITY_CODE” 

o Click [Create] 

 SASSY-SABRS Relationships 

o In the “Edit Relationships” window, click “Create New” 

o In the Left Table Name, select “Repairparts10” 

o In the Left Column Name, select “DOCUMENT_NUMBER” 

o In the Right Table Name, select “M67446-no duplicates” 

o In the Right Column Name, select “Std Doc No” 

o Click OK 

o Click [Create] 
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The relationships are formed at this point. 

 
 

Figure 11.   Relationship view of the databases 

G. UPDATING COST INDICIES 

The FY 11 Enhance Inflation Calculator1 from NCCA (Naval Center for Cost 

Analysis) was used to update all costs to FY 10. All costs listed in the thesis hereafter are 

listed as FY 2010$. 

 

 

                                                 
 

1 http://www.ncca.navy.mil/services/inflation.cfm 
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APPENDIX C.  DETAILED REGRESSION RESULTS 

A. INTRODUCTION 

This appendix provides the detailed regression results in the attached Excel 

spreadsheet, which may be accessed by clicking here. 

B. TABS 

The following tabs describe the information inside the Excel spreadsheet 

Data 

1. Inventory: Possessed inventory data from 2000 to 2009. Cells H:AK describes 
the PivotTable of Possessed Inventory Data, by RAC. Cells AM:AT describe 
the PivotTable of Possessed Inventory Data, consolidated across all RAC.  

2. MCBUL 3000: List of TAMCN in the MCBUL 3000.  
3. TAMCN: References the TAMCN to a description 

 
Cost Data 
4. From Access: Data from access. Formatted by RAC, Year, TAMCN, MCBUL 

3000 (To extract out only MCBUL 3000 TAMCNS), Cost, FY 2010 (Cost 
adjusted to FY 2010 figures) 

 
Analysis 
5. Pivot: Pivot Table from “From Access” tab. Columns K onwards decomposes 

the spreadsheet data from the “From Access” tab to rows and includes the 
inventory data. Column V:AA are placeholders to describe the cost per 
inventory. Columns AC:AF describes which year to start (due to lack of data, 
or whether the equipment is new) 

6. Regression: 770 TAMCNS X 6 Models = 4620 individual regressions done 
7. Summary by MIMMS: Extraction of the best regression models. Column V 

describes which model to use. Column W describes the R2 value. Column AE 
describes the 2011 cost 

8. Bad TAMCNS: Cells H11 to H19 describes the list of TAMCNS with “BAD” 
regressions, extracted out from “Regressions” Tab 

9. Overall Summary: Overall Performance data, aggregated. Cells A3 to H12 are 
used in this thesis. 

 

http://edocs.nps.edu/npspubs/scholarly/theses/2010/Dec/10Dec_Wee_AppC.xls
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APPENDIX D.  LISTING OF TAMCN-RACS MANUALLY 
DELETED FOR LOG-LINEAR MODELS 

Number RAC TAMCN 

1 MIM001 A0882 

2 MIM001 A2042 

3 MIM001 A2068 

4 MIM001 D0031 

5 MIM002 A0069 

6 MIM002 A0124 

7 MIM002 A0273 

8 MIM002 A0807 

9 MIM002 A2068 

10 MIM002 B0392 

11 MIM002 E0055 
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